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Biophysical Chemistry Laboratory 

Apparent dissociation constant (𝐾!) of a Porphyrin 
Dr. Maria Ballester and Dr. Victor Castro 

1 Abstract 

The purpose of this laboratory is to determine the apparent acid dissociation constant, 𝐾!, by estimating the p𝐾! 
value of a porphyrin using visible spectrophotometry. This apparent p𝐾! value is measured by graphic interpolating the 
absorbance changes obtained at varied wavelengths for different acid concentrations using the Henderson–Hasselbach 
equation. 

2 Introduction 

2.1 The porphyrin Spectrum 

A porphyrin is a large ring molecule consisting of four pyrroles, which are smaller rings made from four carbons 
and one nitrogen. These pyrrole molecules are connected together through a series of single and double bonds which 
forms the molecule into a large ring. Some porphyrins occur in Nature while others are made in the laboratory through 
chemical synthesis. Figure 1a shows a free base porphin, characterized by having two hydrogen atoms in the center of 
the ring. Figure 1b shows the visible absorption spectra, at room temperature, of a freebase porphyrin (blue) and its 
protonated state (red). The spectrum is characterized by a main peak (soret) followed by a series of smaller peaks (Q 
bands). These peaks are mainly due to electronic transition and molecular vibrations. They are also dependent on the 
orientation (polarization) of the electric vector of the absorbed light. 

(a) (b) 

Figure 1. Structure of a freebase porphyrin and its spectrum. 

2.2 Dissociation Constant 

In the Brønsted Acid-Base theory, all acid-base reactions involve the transfer of an H" ion (or proton). For example, 
weak acids can experience a process in which they dissociate into a conjugate base and a proton 

HA ⇌ A# +H" Eq. 1 
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in which HA represents the acid, H" the proton, and A# the base. A measure of the strength of an acid in a solution is 
the dissociation or equilibrium constant (𝐾!). The dissociation constant can be calculated by the equation: 

𝐾! =
[H"][A#]
[HA]  Eq. 2 

Thus, at the half equivalence point, when [A#] is equal [HA], the H" molarity is equal to 𝐾!.  

Another measure of the strength of an acid was proposed by Sørenson in 1909. It consists in calculating the negative 
of the logarithm of a quantity. Using this approach, p𝐾! is the negative of the logarithm of the acid-dissociation 
equilibrium constant, p𝐾! = − log𝐾!. Hence, the "p" stands for “take the negative of the logarithm of …”. For example, 
the "p" in pH stands for “take the negative of the logarithm of H"”. Using this approach, Eq. 2 becomes: 

p𝐾! = pH − log$%
[A#]
[HA] 

Eq. 3 

Thus, when [A#] equals [HA] the solution’s pH is equal to p𝐾! of the HA species. 

2.3 Porphyrins 

In this experiment you will be using a porphyrin. As a freebase, the un-protonated form of a porphyrin solution 
(porphyrin + solvent) (P) is more stable. But when acid is added, a new equilibrium is established and the diprotonated 
state is preferred (P&"). The relation between the concentration of the system components, including the freebase 
porphyrin, its diprotonated form, and any excessive amount of acid, can been described in terms of acid–base 
equilibrium: 

P&" ⇄ 2H" + P Eq. 4 

We can find the dissociation constant for the protonation of a porphyrin by 

𝐾! =
[2H"]	[P]
[P&"]  Eq. 5 

Our goal is to find this stoichiometric equilibrium constant, defined in terms of the concentration ratio [P]/[P&"], through 
a UV-vis spectra analysis.  

2.4 Beer’s Law 

Beer’s Law states that the absorption of light in a solution is given by: 

𝐴 = ϵℓ[X] Eq. 6 

where 𝐴 is the absorbance, ϵ is the molar absorption coefficient (M#$cm#$) of the solution, ℓ is the path length of the 
cell (cm) containing the solution, and [X] is the molar concentration of the solution. In the case of mixtures, the 
absorbance is the sum of the separate absorbencies of each species: 𝐴 = 𝜖$ℓ	[X$]+ 𝜖&ℓ	[X&] + ⋯. 

Consider the case of a freebase porphyrin of concentration [X] that has been protonated by the process of adding 
an acid gradually. Keep in mind that although the concentration of the overall solution changes, the concentration of 
the porphyrin remains the same, [X]. In Fig. 2 we can see the three snapshots of the process: the blue curve is the 
spectrum of the freebase porphyrin, the green curve is the spectrum of an arbitrary intermediate stage, and finally the 
red curve is the spectrum of the protonated stage. From the figure, we can see that the protonated curve has a maximum 
peak at a wavelength of 𝜆'. The absorbance of the solution at this point is given by 

𝐴' = 𝜖'	ℓ	[X] Eq. 7 

where 𝜖' is the molar absorptivity of P&". At this same wavelength, the freebase porphyrin and the intermediate stage (a 
combination of the freebase and protonated species) have absorbances of 

𝐴() = 𝜖()	ℓ	[X] Eq. 8 
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Figure 2. The blue curve represents the spectrum of the unprotonated porphyrin (freebase). The green curve is an intermediate state 

of protonationn, while the red curve represents the protonated form of the porphyrin. 

and 

𝐴 = 𝜖'	ℓ	[P&"]+ 𝜖()	ℓ	[P] Eq. 9 

respectively. In this case, 𝜖() is the molar absorptivity of P. [P&"] and [P] are the concentrations of both species in the 
intermediate stage, such that the total concentration is given by 

[X] = [P&"] + [P] Eq. 10 

These equations can be combined to obtain 

[P]
[P&"] =

𝐴 − 𝐴'
𝐴() − 𝐴

 Eq. 11 

3 Method: p𝐾< calculation 

The acid dissociation constant, 𝐾!, can be evaluated graphically by converting Eq. (5) into a logarithmic form, 
known as the Henderson–Hasselbalch equation: 

log$%𝐾! = log$%[2H"] + log$%
[P]
[P&"] 

Eq. 12 

We can know use the negative base-10 logarithm of the acid dissociation constant (𝐾𝑎) of a solution to define of p𝐾! as 

p𝐾! = − log$%𝐾! Eq. 13 

Thus 

−p𝐾! = log$%[2H"] + log$%
[P]
[P&"] 

log$%
[HP]
[HP&"] = −p𝐾! − log$%[2H"] 

Finally, using Eq. (11), we get 
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log$% =
𝐴 − 𝐴'
𝐴() − 𝐴

> = −p𝐾! − log$%[2H"] Eq. 14 

Since we cannot measure [2H"] directly, we are only able to find an apparent (observed) dissociation constant, 
𝐾!,+),, for the porphyrin, using 

log$% =
𝐴 − 𝐴'
𝐴() − 𝐴

> = −p𝐾𝑎,obs − log$%[Acid] Eq. 15 

were [Acid] is the concentration of the acid added to the solution, which is only proportional, but not equal, to the 
proton concentration in solution ([Acid] ∝[2H"]). Although it appears that we could get −p𝐾! directly by using Eq. 15 
and then finding where the straight line intercepts the vertical axis, experimentally that is not the case. 

Figure 3 shows a plot of log$%B𝐴 − 𝐴'C/(𝐴() − 𝐴) vs. − log$%[Acid] used to find the apparent value of p𝐾!. First, the 
experimental data is fitted to a straight line by using the least-squared linear method. We can now use the fact that when 
the straight line intercepts the horizontal axis, the value of log$%B𝐴 − 𝐴'C/(𝐴() − 𝐴) is zero. Hence, by using Eq. 15 we 
get p𝐾!,+), = − log$%[Acid]. It is interesting to note that at this intercept point [P]/[P&"] = 1, indicating that the 
concentrations of the two species are equal; this is called the isosbestic point.  

 

Figure 3. Plot of log!"$𝐴 − 𝐴#'/(𝐴$% − 𝐴) vs. − log!"[Acid] leads to the value of the apparent or observed p𝐾&.  

4 Experimental Procedure 

4.1 Before the experiment 

1. Set up the spectrometer to a temperature of 25℃. Make all measurements at the same temperature. 

2. You should have the following stock solutions available: 

a. A porphyrin in solution with toluene. Write down the name of the porphyrin and its concentration (about 
𝟏𝟎#𝟓 M). 

b. TFA solution (about 𝟏𝟎#𝟐 M). Write down its concentration. 

c. HCl solution (about 𝟏𝟎#𝟐 M). Write down its concentration. 

4.2 During the experiment 

1. Follow the procedures in the annex below to set the zero value and baseline of the spectrometer. Use toluene 
as the blank. 
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2. Create a main folder following the format "porphyrin-solvent-date". For example, oetpp-toluene-
20220913. Inside create two folders to store the data: one for TFA and one for HCl. 

3. Prepare a cuvette with 2.0 mL of the porphyrin. This is your freebase. Put it in the spectrometer and get its 
spectrum. Save it in the TFA folder when it’s done with a name such as tfa-0ul. 

4. Use a pipette to deliver 2 µL of acid (TFA) into the cuvette. Put the sample in the spectrometer and get its 
spectrum. Save the file when it’s done with a name such as tfa-2ul.  

5. Repeat step #4 until the absorbance of the protonated soret does not change, or there is no more space in the 
cuvette. Name the files consecutively: tfa-4ul, tfa-6ul, tfa-8ul, etc. 

6. Clean the cuvette (or use a new one) and repeat from steps #3 through 5, this time using HCl. 

5 Calculations and Analysis. 

You should perform the analysis of your data using a spreadsheet, such as MS Excel. 

1. Ask your instructor to help you export the data to MS Excel. You should have two data sets of the same 
porphyrin, one for TFA and one for HCl. The data has information of absorbance vs. wavelength for all the 
different concentrations of the acid. 

2. Make a plot of log$%B𝐴 − 𝐴'C/(𝐴() − 𝐴) vs. − log$%[Acid], as shown in Fig. 2 above. 

3. Find the intercept with the horizontal axes and calculate the p𝐾! value. 

4. When calculating the values of 𝐾! and p𝐾! be sure to perform a propagation of errors for each value you 
calculate. Assume a nominal error of ±0.5 for each absorbance measurement.  

5. What is the predominate random experimental error? Note that correctible student mistakes are not random 
experimental errors. For example, spills or not following the instructions produce systematic errors, so you 
should not report them as random errors.  

6 References 
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Using the Shimadzu UV-2600 Spectrometer 

Introduction 

Module Configuration 

You will be using the UVProbe software to take the data. Of the three measurement modules available, you will be 
using the Spectrum module. You can select the module from the [Window] menu (Fig. 1). 

   

Figure 1. Selecting the Spectrum Module. 

Measurement Procedure 

When measuring samples in the spectrum module, follow the steps below. 

 

Create a Measurement Method 
(Parameter) 

↓ 

Save the Measurement Method 

↓ 

Auto Zero and Baseline Correction 

↓ 

Set the Sample 

↓ 

Start Measurement 

↓ 

Measurement Completion 
Save Data 
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Creating the Measurement Method (Parameter) 

1. Click [Method] in the [Edit] menu and the [Spectrum Method] window appears. 

(a) (b)  

Figure 2. Setting the Measurement Method (Parameter) 

No. Name Description 

1 Wavelength Range Sets up the wavelength range (nm). 

2 Scan Speed Sets up the wavelength scanning speed. The slower the speed, the more noise can be reduced. 

3 Sampling Interval 

Sets up the interval between measurement data. You can set it to one of the following intervals: 0.01 
nm. 0.05 nm. 0.1 nm. 0.2 nm. 0.5 nm. 1.0 nm. 2.0 nm. or 5.0 nm. 
Auto sampling interval: Automatically sets the interval to the maximum not exceeding 1.800 points 
within the specified wavelength range. 

4 Scan Mode 

Single: Enter a file name. etc., for each measurement. 
Auto: Measurement takes place using prescribed file names. Use this feature to omit file name input 
operation. 
Repeat: Measurement takes place repeatedly using prescribed file names. Repetitions: 2 to 100. Time 
Interval: 0 seconds to 9999 seconds. 

Table 1 – Measurement tab 

2. Set the [Measurement] tab 

(1) Click the [Measurement] tab (Fig. 2b). 

(2) Enter the wavelength range (nm). We will be working between 750 nm to 350 nm. 

(3) Use the [▼] key to select [Scan Speed]. Select Fast. 

(4) Select [Single]. The spectrum measurement is performed only once. 

(5) Select a sampling interval of 0.5 nm in the [Sampling Interval] box. Make sure the [Auto Sampling 
Interval] box is unchecked. 

 

3. Set the [Instrument Parameters] tab 
(1) Click the [Instrument Parameters] tab (Fig.3). 

(2) Use the [▼] key to select the appropriate measuring mode. 

(3) Use the [▼] key to select the appropriate slit width. 

(4) Click [OK] 

 UV-2600/2700 SERIES   53

3.4  Measurement Procedure

3

3.4.1 Creating the Measurement Method (Parameter)

1 Click [Method] in the [Edit] menu.
The [Spectrum Method] window appears.

Fig.3-32 

2 Set the [Measurement] tab.

Fig.3-33 

1 Click the [Measurement] tab.
2 Enter the wavelength range (nm).
3 Use the [T] key to select [Scan Speed].

3

1

5

4

2
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Figure 3. Instrument Parameter. 

4. Saving the Measurement Method 

 

Figure 4. Saving the method. 

Click [Save As] from the [File] menu. The [Save Spectrum File] window appears (Fig.4). 

(1) Enter the file name. Make sure you save it in your external USB stick. 

(2) Click [▼] to select [Method File (*.smd)] for the file type. 

(3) Click [Save].  

5. Auto zero and Baseline Correction 

The system corrects the baseline so that the 0 (zero) Abs line (100 % line for transmittance or reflectance) is leveled 
in the specified wavelength range under the current conditions of the sample compartment. 

• When correcting the baseline after the instrument has not been used for a long period of time, turn on the 
power and wait for about one hour until the spectrophotometer enters a stable status. 

• When measurement conditions are changed, be sure to perform the baseline correction. 

• The default correction wavelength range that appears for baseline correction is the measurement wavelength 
range set in the Measurement Method window. 

3  UVProbe Basic Operation

54   UV-2600/2700 SERIES

4 Select [Single].

If [Single] is selected, the spectrum measurement is performed only once.
5 Check the [Auto Sampling Interval] box.

When the [Auto Sampling Interval] box is checked, the number of data points is automatically 
set within the measurement wavelength range already set to the maximum within a scope not 
exceeding 1,800.

3 Set the [Instrument Parameters] tab.

Fig.3-34 

1 Click the [Instrument Parameters] tab.

2 Use the [T] key to select the appropriate measuring mode.

3 Use the [T] key to select the appropriate slit width.

4 Click [OK].

1

32
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Figure 5. Auto zero and baseline. 

(1) Open the sample compartment cover of the spectrophotometer and insert two cuvettes of solvent (blanks) in 
the cell holders (Fig.6). Click on [Auto zero] to zero the instrument at the starting wavelength (Fig.5). 

(2) Click [Baseline] on the [Instrument Control Button] bar to zero the baseline over the spectrum region 
of interest. The [Baseline Parameters] window appears. 

(3) Verify that the displayed correction range is the same as the wavelength range specified in the [Spectrum 
Method] and click the [OK] button. 

• Baseline correction starts. Do not open the sample compartment cover until it is completed. 

• The spectrophotometer's status is displayed in the Instrument Status window. 

• After the baseline correction is finished, it returns to the baseline start wavelength and is ready to measure. 

• Open the sample compartment cover and remove the sample cuvette. 

6. Set the Sample 

(1) Prepare the sample. Fill out the cuvette up to ¾ of its volume. 

(2) Open the sample compartment cover of the spectrophotometer and insert the cell containing the sample into 
the cell holder on the sample side. 

(3) Close the sample compartment cover. 

(4) The rear holder is the reference compartment, and the front holder is for the sample. The optical sides of the 
cuvettes need to be facing the sides. 

    

Figure 6. Setting the sample. 
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7. Start Measurement 

• Click [Start] on the [Instrument Control Button] bar. The Measurement begins. 

 

Figure 7. Start a measurement. 

8. Measurement Completion/Save Data 

(a)      (b)  

Figure 8. Saving data. 

When measurement is complete, the [New Data Set] window appears (Fig. 8a).  

a) Click the Browse (...) button (Fig. 8a) and the [New Filename] window appears (Fig. 8b).  

b) If this is the first measurement of a sequence (the freebase porphyrin spectrum), create a folder on your external 
USB stick following the format "porphyrin-solvent-date". For example, say you used OETPP in water on 
September 13, 2022, then your folder should be named: OETPP-water-20220913.  

c) For subsequent measurements, select the destination folder where you want to save the data file. Use the "acid 
name-concentration" format for these. For example, for TFA, starting with the freebase (concentration 0	𝜇L) 
and making 2	𝜇L increments the file names will be (note that we use ul for 𝜇L): 

tfa-00ul 

tfa-02ul 

tfa-04ul ... 

d) After entering the filename, click [Open]. The [New Filename] window closes, and then the folder path name 
and the file name appear in the [File] field of the [New Data Set] window. 

e) Confirm that the correct path name and file name are displayed in the [File] field of the [New Data Set] 
window and click the [OK] button. 

f) At this point, data has been collected and named, but the data is stored in memory only; it is not saved to disk. 
If you close UVProbe at this point the data would be lost.  

g) Click [Save] from the [File] menu to save the data. 

h) Select the appropriate data directory in the [Save In] box at the top of the dialog box.  
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i) Enter the same name you used in step (d) and select “.spc” in the [Save As Type] list. 

j) Click [Save]. 

Graph Settings 

Change Graph Scales 

You can change graph axis scales directly on the graph. Click the upper (or lower) limit value of the axis scale. 

   

Figure 9. Graph scales. 

• When the upper (or lower) limit value is highlighted, input the desired value, and press the key. 

• Using a similar procedure, change the upper (or lower) limit of the other axis scale. 

Change Graph Display Setting 

From [Customize] on the graph shortcut menu, you can control the width and colors of graph lines as well as the 
format and size of label fonts. 

• Right-click in the graph area and click [Customize] from the shown menu. The [Customize Graph] window 
appears. 

• You can change the Graph Line Colors, Graph Line Width, and the Axis Label Font. 

 

Figure 10. Customize display settings.  
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Quick Guide - Shimadzu UV-2600 Spectrometer 
1. Turn on the UV-2600 spectrometer as soon as you get in the lab. This will give it enough time to warm it up. 

2. Clean the cells; rinse with distilled water and let dry. Handle cells by the fogged sides, not the clear sides. Always 
use the same cell for the reference.  

3. Open the UVProbe software. Click on the Connect icon on the bottom menu of the initial screen. The system will 
go through a series of instrument checks. Wait until this is completed. All bullets should be green. 

4. Select the Spectrum Mode and click on the Method Manager (or Ctrl+M).  

• Click the [Measurement] tab.  

o Enter a wavelength range (nm) of 750 nm to 350 nm. 

o Select Fast in [Scan Speed].  

o Select [Single].  

o Select 0.5 nm in [Sampling Interval]. Make sure the [Auto Sampling Interval] box is unchecked. 

• Click the [Instrument Parameters] tab. 

o Select Absorbance in the measuring mode. 

• Click [OK] 

• You can save this method for later use. 

5. Insert two cuvettes filled with solvent into the spectrometer. Make sure that there are no air bubbles and wipe the 
optical faces of the cuvettes with a tissue. The rear holder is the reference compartment, and the front holder 
is for the sample. The optical sides of the cuvettes need to be facing the sides.  

6. Click on [Auto zero] and then select [Baseline]. Ensure the wavelengths are correct, then click [OK]. A baseline 
will be recorded.  

7. Remove the sample cuvette of solvent. 

8. Insert a sample to measure. Press [Start] and the spectrum will be recorded. You should see the line being plotted 
from right to left.  

9. When the scan is completed, the [File Name Dialog] box will appear. In the [Enter File Name] box type in 
the file name (use the convention). In the [Enter Comment] box write the name of the porphyrin, the solvent used, 
and the name an amount of acid used.  

10. Click (Browse ...) button to open the [New Filename] window. If this is the first measurement of a sequence, 
create a folder on your external USB stick and name it or select the destination folder for subsequent measurements. 

11. Click [Open]. The [New Filename] window closes, and then the folder path name and the file name appear in 
the [File] field of the [New Data Set] window. Click the [OK] button. 

12. Click [Save] from the [File] menu to save the data and select the appropriate data directory in the [Save In] 
box at the top of the dialog box. Enter the same name you used in step (10) and select “.spc”. Click [Save]. 

13. You will repeat steps 9 to 13 for all the other samples.  

14. Remove your sample and reference. Rinse the cells and let them dry 

15. Turn off the spectrometer and quit the software. Don’t forget to save any files left. 
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